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Preface

For details, see the following topics:

* Progress Corticon documentation

* Overview of Progress Corticon

Progress Corticon documentation

The following documentation, as well as a What's New in Corticon document, is included with this
Progress Corticon release:

Corticon Tutorials

Corticon Studio Tutorial: Basic Rule Introduces modeling, analyzing, and testing rules and
Modeling decisions in Corticon Studio. Recommended for
evaluators and users getting started. See also the
PowerPoint-as-PDF version of this document that is
accessed from the Studio's Help menu.

Corticon Studio Tutorial: Advanced Rule | Provides a deeper look into Corticon Studio's capabilities
Modeling by defining and testing vocabularies, scope, collections,
messages, filters, conditions, transient data, and
calculations in multiple rulesheets that are assembled
into a Ruleflow. See also the PowerPoint-as-PDF version
of this document that is accessed from the Studio's Help
menu.
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Corticon Tutorial: Using Enterprise Data
Connector (EDC)

Introduces Corticon's direct database access with a
detailed walkthrough from development in Studio to
deployment on Server. Uses Microsoft SQL Server to
demonstrate database read-only and read-update
functions.

Corticon Studio Documentation: Def

ining and Modeling Business Rules

Corticon Studio: Installation Guide

Step-by-step procedures for installing Corticon Studio
on computers running Microsoft Windows as a
standalone installation and as a part of an existing
Eclipse installation such as Progress Developer Studio
for OpenEdge. Shows how to enable internationalization
on Windows.

Corticon Studio: Rule Modeling Guide

Presents the concepts and purposes the Corticon
Vocabulary, then shows how to work with it in Rulesheets
by using scope, filters, conditions, collections, and
calculations. Discusses chaining, looping, dependencies,
filters and preconditions in rules. Presents the Enterprise
Data Connector from a rules viewpoint, and then shows
how database queries work. Provides information on
versioning, natural language, reporting, and localizing.
Provides troubleshooting and many Test Yourself
exercises.

Corticon Studio: Quick Reference Guide

Reference guide to the Corticon Studio user interface
and its mechanics, including descriptions of all menu
options, buttons, and actions.

Corticon Studio: Rule Language Guide

Reference information for all operators available in the
Corticon Studio Vocabulary. A Rulesheet example is
provided for many of the operators. Includes special
syntax issues, handling arithmetic and character
precedence issues.

Corticon Studio: Extensions Guide

Detailed technical information about the Corticon
extension framework for extended operators and service
call-outs. Describes several types of operator extensions,
and how to create a custom extension plug-in.

Corticon Server Documentation: Deploying Rules as Decision Services

Corticon Server: Deploying Web
Services with Java

Details installing the Corticon Server as a Web Services
Server, and then deploying and exposing Decision
Services as Web Services on the Pacific Application
Server (PAS) and other Java-based servers. Includes
SOAP and JSON/RESTful samples. Presents the
features and functions of the browser-based Server
Console. Provides administrative instructions for the
Pacific Application Server.
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Corticon Server: Deploying Web
Services with .NET

Details installing the Corticon Server as a Web Services
Server, and then deploying and exposing decisions as
Web Services with .NET. Provides installation and
configuration information for the .NET Framework and
Internet Information Services (IIS) on various supported
Windows platforms.

Corticon Server: Integration &
Deployment Guide

An in-depth, technical description of Corticon Server
deployment methods, including preparation and
deployment of Decision Services and Service Contracts
through the Deployment Console tool. Discusses
relational database concepts and implementation of the
Enterprise Data Connector. Goes deep into the server
to discuss state, persistence, and invocations by version
or effective date. Includes server monitoring techniques,
performance diagnostics, and recommendations for
performance tuning.

Overview of Progress Corticon

Progress® Corticon® is the Business Rules Management System with the patented "no-coding”
rules engine that automates sophisticated decision processes.

Progress Corticon products

Progress Corticon distinguishes its development toolsets from its server deployment environments.

¢ Corticon Studio is the Windows-based development environment for creating and testing

business rules:

* When installed as a standalone application, Corticon Studio provides the complete Eclipse
development environment for Corticon as the Corticon Designer perspective. You can use
this fresh Eclipse installation as the basis for adding other Eclipse toolsets.

* When installed into an existing Eclipse such as the Progress Developer Studio (PDS), our
industry-standard Eclipse and Java development environment, the PDS enables development
of Corticon applications in the Corticon Designer perspective that integrate with other
products, such as Progress OpenEdge.

Note: Corticon installers are available for 64-bit and 32-bit platforms. Typically, you use the
64-bit installer on a 64-bit machine, where that installer is not valid on a 32-bit machine. When
adding Corticon to an existing Eclipse, the target Eclipse must be an installation of the same
bit width. Refer to the Corticon Studio: Installation Guide to access, prepare, and install Corticon

Studio.

Studio Licensing - Corticon embeds a time-delimited evaluation license that enables
development of both rule modeling and Enterprise Data Connector (EDC) projects, as well as
testing of the projects in an embedded Axis test server. You must obtain Studio development
licenses from your Progress representative.

* Corticon Servers implement web services for business rules defined in Corticon Studios:
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* Corticon Server for deploying web services with Java is supported on various application
servers, and client web browsers. After installation on a supported Windows platform, that
server installation's deployment artifacts can be redeployed on various UNIX and Linux web
service platforms as Corticon Decision Services. The guide Corticon Server: Deploying web
services with Java provides details on the full set of platforms and web service software that
it supports, as well as installation instructions in a tutorial format for typical usage.

* Corticon Server for deploying web services with .NET facilitates deployment of Corticon
Decision Services on Windows .NET Framework and Microsoft Internet Information Services
(IIS). The guide Corticon Server: Deploying web services with .NET provides details on the
platforms and web service software that it supports, as well as installation instructions in a
tutorial format for typical usage.

Server Licensing - Corticon embeds a time-delimited evaluation license that enables evaluation
and testing of rule modeling projects on supported platform configurations. You must obtain
server deployment licenses and server licenses that enable the Enterprise Data Connector
(EDC) from your Progress representative.

10
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Supported configurations

Software Component

Certified on Version

JDK JDK 1.7.0_05
Eclipse (32-bit and 64-hit) 431

EMF 29.1

GEF 39.1RC1
GMF 1.7.0

Progress Corticon: Extensions Guide: Version 5.4
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Overview

You can extend the set of operators available to your users by writing your own Java classes.

Extension Description Example Invocation

Attribute Extended Operator | Extensions that you invoke

. . . .zip.ch At (2
against attributes of a given Customer. zip. characterht (2)

type. For example, you can String Attribute Extended
define an extension that can be | Operator characterAt returns
invoked against String a String consisting of the
attributes. second character of

Customer.zip.

Collection Extended Operator |Extensions that operate on
collections. For example, you
can define an extension that
can be invoked against a Collection Extended Operator
collection of String attributes. |uniqueCount returns a count
of the number of unique String
values in collection

orditem. sku.

Order.uni=
orditm.sku->uniqueCount

Progress Corticon: Extensions Guide: Version 5.4 13



Chapter 2: Overview

Extension

Description

Example Invocation

Sequence Extended Operator

Extensions that operate on
sequences. For example, you
can define an extension that
can be invoked against a
sequence Decimal attributes.

Trade.mavg=
seaurity.price->sortedBy (rerketDate)
->mavg (30)

Sequence Extended Operator
mavg returns the moving
average of a sequence of price
values in security.price.

Stand-Alone Extended Operator

Function you can use in any
Rulesheet expression. A
Stand-Alone extension can take
any number of input parameters
returns a value.

Shape.circumference =
SeMath.getCircumference
(Shape.radius)

Stand-Alone Extension

SeMath.getCircumference
converts Shape.radius to
Shape.circumference.

Service Call-out Extension

Extensions you can use in a
Ruleflow. A Service Call-out is
an extension that can directly
access and update the universe
of rule engine facts via the
Service Call-out application
programming interfaces.

CreditLockup

o
w

AssessRisk

Service Call-out Extension
CreditLookup retrieves credit
data from a consumer credit
agency and updates rule engine
facts accordingly. The system
forwards the updated facts to
Rulesheet AssessRisk for
analysis.

There are several ways to add your extension classes to the system. The approach you use
depends on whether you are using Corticon in the Progress Developer Studio (Eclipse), or the
Foundation APIs in a non-Eclipse setting.

14
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Java class conventions

Your extension classes must conform to certain standards. Although you are free to choose any
package and class nhames for your extensions, your classes must implement special marker
interfaces to identify them as containers of extension logic:

Interface Name
com.corticon.services.extensions.

Description

ICcStringExtension

Identifies your class as a container of String Attribute
Extended Operators.

ICcDhateTimeExtension

Identifies your class as a container of Date, Time and/or
DateTime Attribute Extended Operators.

ICcDecimalExtension

Identifies your class as a container of Decimal Attribute
Extended Operators.

ICcIntegerExtension

Identifies your class as a container of Integer Attribute
Extended Operators.

ICcCollectionExtension

Identifies your class as a container of Collection
Extended Operators.

ICcSequenceExtension

Identifies your class as a container of Sequence
Extended Operators.

Progress Corticon: Extensions Guide: Version 5.4
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Chapter 3: Java class conventions

Interface Name Description
com.corticon.services.extensions.

ICcStandAloneExtension Identifies your class as a container of Stand-Alone
Extended Operators

ICcServiceCalloutExtension Identifies your class as a container of Service Call-out
Extensions.

These marker interfaces can be found in:

Usage Scenario Location
Eclipse Eclipse plug-in com.corticon.services
Foundation API Corticon eFoundation API.jar

Corticon Studio is installed with source code examples that illustrate the proper implementation
for each type of extension.

Refer to the source code examples in the Extended Operators and Service Call-outs
folders.
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Attribute extended operators

Attribute Extended Operators apply to specific attribute data types. Consider this example Rulesheet
expression:

Customer.fullName = Customer.name.trimSpaces

Assuming that Customer .name is a String attribute, Attribute Extended Operator trimSpaces
might perform the "trim" function on the value of attribute name, returning the trimmed value, which
the rule engine will assign to Customer. fullname.

To create an Attribute Extended Operator, you must code a Java class, and your class must
implement the marker interface corresponding to the attribute type. For example, to create a String
Attribute Extended Operator, your Java class must implement interface ICcStringExtension.
Example:

package com.acme.extensions;
import com.corticon.services.extensions.ICcStringExtension;

public class S1String implements ICcStringExtension
{ public static String trimSpaces(String astrThis)
{ if (astrThis == null)
{ return null;
}

return astrThis.trim();

}

Attribute Extended Operator methods must be declared public static.
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Chapter 4: Attribute extended operators

The first positional parameter will always be a reference to the attribute upon which the function
is being performed. In this example, the rules engine will pass the current value of Customer.name

to extension method trimSpaces as parameter astrThis; thus, astrThis must be declared
as type String.

An Attribute Extended Operator may accept any number of additional parameters as needed.
Consider the following Rulesheet expression:

Customer.initial = Customer.name.characterAt (1)

In this example, your Java method would return the first character of Customer.name:

public static String characterAt (String astrThis, BigInteger abilIndex)
{
if (abiIndex == null)
{
return null;

}
int 1liIndex = abiIndex.intValue() - 1;

if (liIndex < 0 || liIndex >= astrThis.length())
{
return null;

}

return astrThis.substring(liIndex, liIndex + 1);

}

As always, the first positional parameter astrThis will contain a reference to the String upon

which to operate (i.e., a reference to the value of Customer .name). The second parameter will
contain the character index (i.e., literal 1).

Your extension would return the character at the specified index as a String, and the rules engine
will assign Customer.initial the value of your returned String.

For Attribute Extended Operators, you must limit your parameter and return types to the following:

JavaType Corticon Type
java.math.BigInteger Integer
java.math.BigDecimal Decimal

java.lang.Boolean Boolean
java.util.Date Date, Time or DateTime
java.lang.String String

Note that you may code any number of extension methods in a Java class, and you can supply

one or more Java classes; regardless, the system will discover all of your methods via Java
reflection.

18
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Collection extended operators

Collection Extended Operators process a collection of input attribute values and return a single
value. Consider this example expression:

ord.asteriskFlag = orditem.sku->allContain(‘*’)

Assuming that asteriskFlag is a Boolean attribute and orditem. sku refers to a collection of
String attributes, Collection Extended Operator al1Contain will return a Boolean value true if all
instances of String attribute sku contain an asterisk.
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Chapter 5: Collection extended operators

To create a Collection Extended Operator, you must code a Java class, and your class must
implement marker interface ICcCollectionExtension. Example:

package com.corticon.operations.extended.examples.operators.setl;

import java.util.HashSet;

import com.corticon.services.extensions.ICcCollectionExtension;

public class SlCollection implements ICcCollectionExtension

{

public static Boolean allContain(String[] astrInputArray, String astrLookFor)

{

if (astrInputArray == null

return null;

for (String lstrInput
{

if (lstrInput != null)

{

astrInputArray.length == 0)

astrInputArray)

if (lstrInput.indexOf (astrLookFor) < 0)

{

return new Boolean (false);

}
}

return new Boolean (true);

Collection Extended Operator methods must be declared public static.

In this example, the first positional parameter of method al1Contain is an array of String instances.
The rules engine will populate this array with the String values in orditem. sku (i.e., the collection

upon which the method operates).

The example Java method analyzes this array and returns a Boolean value. The rules engine will
then assign ord.asteriskFlag the Boolean return value.

Note that you cannot code Collection Extended Operators for entity instances, nor can you code
extensions for Collections or Sequences of entity instances. For example, the following expression

is not allowed:

orditem->allContain(‘*’")

In other words, you can only code Collection Extended Operators to process collections of attribute

values.

When implementing Collection Extended Operators, you must limit your parameter and return

types to the following:

JavaType Corticon Type
java.math.BigInteger Integer
java.math.BigDecimal Decimal

java.lang.Boolean Boolean

java.util.Date

Date, Time or DateTime

java.lang.String

String

20
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The first positional parameter must be an array of one of these allowable types.
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Chapter 5: Collection extended operators

22

Progress Corticon: Extensions Guide: Version 5.4



Sequence extended operators

Sequence Extended Operators process a sequence (list) of input attribute values and return a
single value. Consider this example expression:

Trade.mavg=security.price->sortedBy (marketDate)->mavg (30)

Assuming that Trade .mavg is a Decimal attribute, marketDate a Date attribute, and
security.price refersto a collection of Decimal attributes, Sequence Extended Operator mavg

might return a Decimal value that is the moving average of the first 30 instances of sequence
security.price

Progress Corticon: Extensions Guide: Version 5.4 23
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To create a Sequence Extended Operator, you must code a Java class, and your class must
implement marker interface ICcSequenceExtension. Example:

package com.corticon.operations.extended.examples.operators.setl;

import java.math.BigDecimal;
import java.math.BigInteger;

import com.corticon.services.extensions.ICcSequenceExtension;

public class SlSequence implements ICcSequenceExtension

{
private static final int DECIMAL SCALE = 4;

public static BigDecimal mavg (BigDecimal[] abdInputArray, BigInteger
abiElements)

{
if (abdInputArray == null || abiElements == null)

{

return new BigDecimal ("0");

}
int liElements = abiElements.intValue () ;

BigDecimal lbdSum = new BigDecimal ("O") .setScale (DECIMAL SCALE);
int liDenominator = 0;

for (int liIndex = 0; liIndex < abdInputArray.length &&

liIndex < liElements; liIndex++)

{
lbdSum = lbdSum.add(abdInputArray[liIndex]);
liDenominator++;

}
BigDecimal lbdDenominator = new BigDecimal (String.valueOf (liDenominator)) ;

return lbdSum.divide (1bdDenominator, DECIMAL SCALE,
BigDecimal .ROUND HALF UP);
}
}

Sequence Extended Operator methods must be declared public static.

In this example, the first positional parameter of method mavg is an array of BigDecimal instances.
The rules engine will populate this array with the Decimal values in security.price (thatis,
the sequence upon which the method operates).

Note: Collection security.price has been sorted into marketDate sequence via built-in
operator sortedBy.

The example Java method analyzes this array and returns a Decimal value. The rules engine will
then assign Trade .mavg the Decimal return value.

As with Collection Extended Operators, you cannot code Sequence Extended Operators for entity
instances, nor can you code extensions for Collections or Sequences of entity instances.

When implementing Sequence Extended Operators, you must limit your parameter and return
types to the following:
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Java Type

Corticon Type

java.math.BigInteger Integer
java.math.BigDecimal Decimal
java.lang.Boolean Boolean

java.util.Date

Date, Time or DateTime

java.lang.String

String

The first positional parameter must be an array of one of these allowable types.

Progress Corticon: Extensions Guide: Version 5.4
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Stand-alone extended operators

Stand-alone extended operators define functions that can be used in Rulesheet expressions. Unlike
Attribute Extended Operators, they are not tied to Vocabulary attributes and are not associated
with any particular data type.

Users invoke Stand-Alone extended operators by explicitly specifying a class name and method
name in Rulesheet expressions.

Stand Alone extension classes may contain any number of static methods.
Consider this expression:
Circle.circumference = SeMath.getCircumference (Circle.radius)

Assuming Circle.circumference and Circle.radius are both Decimal attributes,
Stand-Alone Extended Operator SeMath.getCircumference might convert the radius to
circumference, which the rule engine will assign to Circle.circumference.

To create Stand Alone Extended Operator, you must code a Java class, and your class must
interface ICcStandAloneExtension. Example:

package com.corticon.operations.extended.examples.standalone.setl;
import java.math.BigDecimal;
import com.corticon.services.extensions.ICcStandAloneExtension;

public class SeMath implements ICcStandAloneExtension
{
public static BigDecimal getCircumference (BigDecimal abdRadius)
{
BigDecimal 1bdBigDecimal = abdRadius.multiply(new BigDecimal (2.0));
1lbdBigDecimal = lbdBigDecimal.multiply(new BigDecimal (Math.PI));
return lbdBigDecimal;
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Chapter 7: Stand-alone extended operators

Stand-Alone Extended Operator methods must be declared public static. Any number of
parameters may be specified. The Rulesheet expression parameter list and return value must
match the extension class method signature; otherwise, the Rulesheet expression will be flagged

as invalid.

In this example, the rules engine will pass the current value of Circle.radius to class
com.corticon.operations.extended.examples.standalone.setl.SeMath method
getCircumference as parameter abdRadius; thus, abdRadius must be declared as type

BigDecimal.

Similarly to Attribute Extended Operators, you must limit parameter and return types to the following:

JavaType Corticon Type
java.math.BigInteger Integer
java.math.BigDecimal Decimal

java.lang.Boolean Boolean

java.util.Date

Date, Time or DateTime

java.lang.String

String

Note that you may code any number of extension methods in a Java class, and you can supply
one or more Java classes; regardless, the system will discover all of your methods via Java

reflection.

1 The user specifies the unqualified part of the class name, namely the class name without the package name.

28
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Service call-out extensions

Service Call-out Extensions are user-written functions that can be invoked in a Ruleflow.

In a Ruleflow, the flow of control moves from Rulesheet to Rulesheet, with all Rulesheets operating
on a common pool of facts. This common pool of facts is retained in the rule execution engine's
working memory for the duration of the transaction. Connection arrows on the diagram specify the
flow of control. Each Rulesheet in the flow may update the fact pool.

When you add a Service Call-out to a Ruleflow diagram, you effectively instruct the system to
transfer control to your extension class a specific point in the flow. Your extension class can directly
update the fact pool, and your updated facts are available to subsequent Rulesheets.

Consider this example:

SelectCandidates CreditLookup.retrieveFICO HAssessRisks

e
uy

After the rule engine finishes processing Rulesheet SelectCandidates, it will transfer control
to Service Call-out Extension class CreditLookup, method retrieveFICO.

Using the Service Call-out API, class CreditLookup, method retrieveFICO can create, retrieve,
update and remove facts. For example, it might look up a customer's FICO score using an external
web service, and update the facts accordingly.

When CreditLookup.retrieveFICO finishes, the system will transfer control to the next
Rulesheet in the Ruleflow. Downstream Rulesheets (for example, AssessRisks) will evaluate
and respond to new facts asserted by your Service Call-out.
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Service call-out API

Your Service Call-outs use an API to retrieve and update facts. The APl is comprised of these

Java interfaces:

Interface Purpose

com.corticon.services.datacbject.ICchatalbjectManager | Provides access to the entire fact

pool. Allows you to create, retrieve
and remove entity instances.

com.corticon.services.dataobject.ICcDataObject | Provides access to a single entity

instance. Allows you to update the
entity instance, including setting
attributes and creating and
removing associations.

These interfaces can be found in:

Usage Scenario

Location

Eclipse

Eclipse plug-in com.corticon.services

Foundation API

Corticon eFoundation API.jar

Your Service Call-out class must implement marker interface ICcServiceCalloutExtension.
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Chapter 9: Service call-out API

Example:

package com.corticon.operations.extended.examples.servicecallouts;

import
import
import

public
{
pub
{

com.corticon.services.dataobject.ICcDataObject;
com.corticon.services.dataobject.ICcDataObjectManager;
com.corticon.services.extensions.ICcServiceCalloutExtension;
class SampleDataService implements ICcServiceCalloutExtension

lic static void retrievePersonInfo (ICcDataObjectManager aDataObjMgr)

for (ICcDataObject l1lPerson
{

aDataObjMgr.getEntitiesByName ("Person"))

String lstrName = "Tom";

Boolean lbMarried = new Boolean (true);

lPerson.setAttributevValue ("name",

lstrName) ;

lPerson.setAttributeValue ("married", lbMarried);

Service Call-out methods must be declared public static.

The system will recognize your Service Call-out method if the method signature takes one parameter
and that parameter is an instance of ICcDataObjectManager.

Recognized classes and methods will appear in the Ruleflow Properties View/Service Name
drop-down list when a Service Call-out shape is selected in the Ruleflow diagram:

== SampleDataService
& CallOutTestl.erf

<;==.Dv

Service Call-out

Corticon Designer - Progress Developer Studio (=]
9 g P
File Edit Mavigate Search Project Ruleflow Run  Window Help
R | 2 Qi E e e e = B Comem )
[ Rule Vocabulary &2 im T T O |l¢ *CallQutTestl.erf &2 =08
[Z1 CallOutVocab “ | 2% palette
E Adult [k ® E
E Event LoadDataM B
= info oadDataManager - Connection
= Kid @ Rulesheet
g :I:r:on () Iterative
= Pricelnfo Reset Info Counter 52 Subflow
= Toy & i Service Call-out
E Woman
4
§ Rule Operators @ Rule Project Ex &% =
I Properties 2 =¥ =08

E@ CallOutTestl.ers

Service Name: |SampleDataService resetinfoCounter =
Description: SampleDataService.resetinfoCounter ek

SampleDataService.setToyPrice

@ CallOutTestl.ert
¢ CallOutTest2.erf
E@ CallOutTest2.ers
@ CallOutTest2.ert

m

SampleDataService.setEventDataEpoch
SampleDataService.matchGuestsByTicket
SampleDataService.matchAdultToKids

4 }

¢ CallOutTest3.erf
E@ CallOutTest3.ers

Example SampleDataService.resetInfoCounter illustrates how a Service Call-out can use
the supplied ICcDataObjectManager to find and update entity instances.

ICcDataObjectManager method getEntitiesByName allows you to retrieve a Set of all entity
instances with a given name. Each element of the returned Set is an instance of ICcDataObject
which offers additional methods to access and update a specific entity instance.

The example finds all Person entities then iterates over them to set attributes Person . name and
Person.married using generic method ICcDataObject.setAttributevalue.
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The Service Call-out API provides your extension class complete access to the fact pool, allowing
you to:

* Find entities in several ways

Read and update entity attributes

* Create and remove entity instances
* Create and remove associations

* Post rule messages

Refer to Service Call-out Java source code examples in your Corticon Studio /Samples/Extended
Operators folder, and see the API Javadocs for more information.
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Creating an extension plug-in

10

You must create an Eclipse plug-in to encapsulate your extensions. The system will automatically
recognize an optional plug-in named:

com.corticon.eclipse.studio.operations.extended.core

You can use your Eclipse IDE to create a plug-in project to develop your extensions and ultimately
prepare them for deployment.

For details, see the following topics:

Setting up your development Eclipse IDE
Creating your plug-in project

Creating the extension locator file
Creating an extension class

Coding your extension class

Updating your plug-in manifest
Organizing imports

Exporting your plug-in

Installing your plug-in

Testing your extension

Troubleshooting extensions

Extension plug-in not resolved by Eclipse

Extension locator file not set up correctly
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* Extension classes not implementing marker interfaces

* Enabling logging to diagnose extensions issues

Setting up your development Eclipse IDE

Creating your plug-in project

To develop plug-ins, you must use the Java Development Kit (JDK), not just a Java Runtime

Environment (JRE).

1. Download and install a supported JDK from www.oracle.com

. Select Window > Preferences > Java > Installed JREs

2
3. Navigate to your downloaded JDK and select it as your default JRE.
4

. Copy tools.jar fromyourJDK's /1ib directoryinto /jre/1lib/ext sothatyoucan compile

and test Rulesheets, .

To create a plug-in project:

1. Using the Java Perspective select:
Select New > Project > Plug-in Project.

¥ New Project

Select a wizard

Create a Plug-in Project

Wizards:
type filter text

=[5 |]

. = General
» == Eclipse Modeling Framework
- = Java
4 [= Plug-in Development
[ Feature Patch
L5 Feature Project
=g Fragrent Project

2 Plug-in Project

" Update Site Project
4 [= Progress Corticon

Lg Rule Project

£ Plug-in frem Existing JAR Archives

Cancel

2. Click Next
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Creating your plug-in project

3. Specify the plug-in Project name
com.corticon.eclipse.studio.operations.extended.core.

¥ New Plug-in Project = @
Plug-in Project ]

Create a new plug-in project

Project name:  com.corticon.eclipsestudio.operations.extended.core

Use default location
CA[CORTICON_WORK_DIR]\workspace\com.cortici Browse...

Project Settings
Create a Java project

Source folder:  src

OQutput folder:  bin

Target Platform
This plug-in is targeted to run with:

@) Eclipse version: 3.5 orgreater w

©) an O5Gi framework: | Equinox

Working sets
[] Add project to working sets

Select...

@ [ <Back |[ Net» Finish

4. Click Next.

The Content dialog opens.
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5.

¥ New Plug-in Project = @
Content e J_ -
Enter the data required to generate the plug-in. /

Properties

1D: com.corticon.eclipse.studio.operations.extended.core
Version: 54.0

Mame: Extended Operators Core Plug-in

Vendor: CORTICON v
Execution Envirenment: |JavaSE-1.7 v‘ IEnvironments...
Options

[7] Generate an activator, a Java class that controls the plug-in's life cycle
com.corticen.eclipsestudio.operations.extended . core. Activator

[7] This plug-in will make contributions to the Ul

[7] Enable API analysis

Rich Client Application

Would you like to create a 3x rich client application? I ¥es @ Mo

@ [ <Back | Net> |[ Fnish |[ Cancel

In the Content dialog:

a) In the Version field, enter a version number for your plug-in. You should specify a version
greater than the version of Studio you installed. For example, if you installed Studio Version
5.4.0, you might specify version 5.4.9. This should ensure that your plug-in supersedes our
example plug-in throughout the 5.4 release.

b) In the Name field, enter Extended Operators Core Plug-in.

¢) Inthe Provider field, enter your company name.

d) Uncheck Generate an activator.

e) Uncheck This plug-in will make contributions to the UL
f) Click Finish to close the dialog.

When prompted to switch to the Plug-in Development perspective, check Remember my

decision, as shown:

* Open Associated Perspective?

This kind of project is associated with the Plug-in Development perspective,

This perspective is designed to support efficient development and integration of
plug-in projects. It adds the Plug-ins and Errer Log views which are particularly
useful,

Do you want to open this perspective now?

Rermember my decision

X5
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Creating the extension locator file

7. Click Yes.

The system switches to Plug-in Development perspective, and then creates a new plug-in
project in your workspace.

8. The plug-in manifest file (MANIFEST.MF) opens to let you configure the new plug-in:

* Plug-in Development - com.corticon.eclipse.studio.operations.extended. core/META-INF/MANIFEST.MF - Progress Developer Studio EI@
File Edit Mavigste Search Project Run  Window Help
- B & BrO-u-w R I THre e
Quick Access B | Q Corticon Designer
& | I3} *com.corticon.eclipse.studio.operations.extended.core &7 =& | &g
i it Overview 0% 2=
% 0|,
General Information Plug-in Content ?—.l
This section describes general information about this plug-in. &

The content of the plug-in is made up of two sections: =

: e R . . &l
10 com.corticon.eclipse.studio.operations.edended.core [ Dependencies: lists all the plug-ins required on this plug-in's
Version: [5.4.0] classpath to compile and run.
Version:
_y Runtime: lists the libraries that make up this plug-in's runtime.
Mame: Extended Operators Core Plug-in
Vendor: CORTICON

Extension / Extension Point Content

Platfarm Filter: This plug-in may define extensions and extension points:

Activator: E4 Extensions: declares contributions this plug-in makes to the

latform.
[7] Activate this plug-in when one of its classes is loaded v P
[ This plug- et |2] Extension Points: declares new function points this plug-in adds to
is plug-in is a singleton the platform.

Execution Environments B
R X X . Testing
Specify the minimum execution environments required to run this plug-

n. Test this plug-in by launching a separate Eclipse application:

Bl JavaSE-17 Add...
#& Launch an Eclipse application in Debug mode
Remove
Exporting
Down To package and export the plug-in:

- o] e v st Wizar
Confiaure JRE associations.. 1. Organize the plug-in using the Organize Manifests Wizard

Update the classpath settings

2. Externalize the strings within the plug-in using the Externalize
Strings Wizard

3. Specify what needs to be packaged in the deployable plug-in on
the Build Configuration page

4. Exportthe plug-in in 2 format suitable for deployment using the
Export Wizard

Overview | Dependencies | Runtime | Extensions | Extension Points | Build | MANIFEST.MF | build.properties

9. Close the plug-in manifest editor. (This task will be completed later.)

Creating the extension locator file

Right click on the /src node in the Package Explorer and select New > File

The system will prompt for a new file name. Specify CcExtensionsLocator. 1lc as shown:
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File

Create a new file resource.

=]

o 020 w=s )

Enter or select the parent folder:

com.corticon.eclipse studio.operations.extended.core/src

| A} <
12 com.corticon.eclipse.studio.operations.extended.care
(= settings
[= bin
(= META-INF
& sic

File name: CcEdtensionsLocator. \d

@ [ FEinish ] [ Cancel

S

Press Finish to proceed.

Creating an extension class

Right click on the /src node in the Package Explorer and select New > Package. Specify the

package name for your new extension classes:

Java Package

Create a new Java package. £

Creates folders comresponding to packages.

| Sourcefolder: com.corticon.eclipse.studio.operations.extended.core/src

Name: com.acme extended.operators

@ [ Enish ][ cancel

Press Finish to proceed.

Right-click on your new package and select New > Class:
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Creating an extension class

Java Class

Create a new Java class.

|| Source folder: com.corticon.eclipsestudio.operations.extended.core/s| Browse...
Package: com.acme.extended.operators Browse...
Enclosing type: ‘ | ‘ Browse.., |
Name: HelloWarld|
Modifiers: private protected

1 1l [] static

Superclass: java.lang.Object Browse...
Interfaces: Add...

Remove

‘Which method stubs would you like to create?

public static void main(String[] args)

Constructors from superclass

Inherited abstract methods

Do you want to add comments? (Configure templates and default value here)
Generate comments

@ [ Anish ][ cConca |

Enter a name for your new Java class (for example, HelloWor1d) and press Finish. The system
will create an empty class definition:

r nl
Java - com.corticon.eclipse studic.operati ore/src/comyac java - Eclipse SDK [E= e
p: opel per i P
File Edit Source Refactor Navigate Search Project Run  Window Help
o-E& & | WYy 33 ip-0-@-idwe- s PHEHED  (faa) "
S~ Gl ~40 v~ E@ Rule Modeling
[# Package Exp 2 % Hielalch_ﬂ =08 . = B[ g Outline 2 =B
& v package com.acme.extended.operators; - R e &Y
12 com.corticon.eclipse.studio.operation . F  com.acme.extended.ops
=i JRE System Library [JavaSE-16] 1:“"“" class HelloWorld @ Helloworld
=) Plug-in Dependencies
8 src )
3 com.acme.extended.operatars
[4] HelloWorld java
CcExtensionsLocator.lc
(= META-INF
[ build.properties
‘ R £ P
[E¢ Problems 52 @ Javadoﬂ [ Dgchmiuﬂ =08
0 items
Description ’ Resource Path Location  Type
o® Writable SmartInsert | 1:1
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Coding your extension class

Code your extension class as shown:

package com.acme.extended.operators;

public class HelloWorld implements ICcStringExtension

{

public static String getHelloWorld(String astrThis)

{

return "Hello World";

Note that Eclipse cannot resolve interface ICcStringExtension:

= Java - com.corticon.eclipse studic.operations.extended.core/src/com/acme/extended/operators/HelloWerld java - Eclipse SDK

[ |

Hi= & | \
Al v ks 5w v
[# Package Bxp 2

5%~
tg com.corticon.eclipsestudic.operation
=i JRE System Library [JavaSE-15]
=4 Plug-in Dependencies
% src
@i com.acme.extended.operators
] HelloWorld.java
|= CcExtensionsLocator.lc
il (= META-INF
@ build.properties

mé

[;_\ Problems &%

1 error, 0 warnings, 0 others

Eile Edit Source Refactor MNavigate Search Project Run  Window Help

e Hierarchy| = O |/ ] HelloWorld java 52

| B0 QU  EEE @ F & [Ema) ®
E@ Rule Modeling
= B[ 8 Outline 1 =0
package com.acme.extended.operators; » W

{

{
return "Hello World”;
}

4

Description
4 3 Emors (1 item)
@ ICcStringExtension cannot be resolved to atype

public class HelloWorld implements ICcStringExtension

public static S5tring getHelloWorld(String astrThis)

@ Javadoc @ Declaration

Wl e Wl T
f#  com.acme.extended.ope
= P HelloWorld
@ ° getHelloWorld(Strir

3 « m r
~ =8

Resource Path Location  Type
HelloWorld,java /com.corticon.eclip.. line3 Java Pro

m F
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Updating your plug-in manifest

Updating your plug-in manifest

To correct build errors, open MANIFEST . MF located in your new plug-in META-INF directory, and
then select the MANIFEST.MF tab and update the manifest as shown in italics below:

Manifest-Version: 1.0
Bundle-ManifestVersion: 2
Bundle-Name: Extended Operators Core Plug-in
Bundle-SymbolicName: com.corticon.eclipse.studio.operations.extended.core
Bundle-Version: 5.4.0
Bundle-Vendor: Your Company
Bundle-RequiredExecutionEnvironment: JavaSE-1.7
Require-Bundle: org.eclipse.core.runtime,
com.corticon.legacy,
com.corticon.services,
com.corticon.thirdparty
Export-Package: .,
com.acme.extended.operators
Eclipse-RegisterBuddy: com.corticon.legacy

These changes will:

¢ Ensure that your plug-in has access to interface 71CcStringExtensionin
com.corticon.services

* Ensure that your locator file CcExtensionLocator. 1c and Java package
com.acme.extended. operators are visible to the Corticon extensions subsystem

* Ensure that your plug-in is registered as a "buddy" with com.corticon.legacy to allow the
Corticon class loader to find your extensions

Click Save to save your manifest changes.

Organizing imports

Activate the HelloWorld Java editor and press CTRL-SHIFT-O to organize imports. The system
will add import com.corticon.services.extensions.ICcStringExtension allowing your
class to build without errors:
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= Java - com.corticon.eclipse studic.operations.extended.core/src/com/acme/extended /operators/HelloWerld java - Eclipse SDK | |
File Edit Source Refactor Navigate Search Project Run Window Help
t-E& & | \ | H-0-QAU- EHE G- @S- POHED & [ Tava | »
Bl vl v®0 o~ - E@ Rule Modeling
£ Pack &3 s Hier | = 8| [J] HelloWorldjava &3 . 4IF com.corticon.eclipse.studio.operations.extended.core = B8 082 =8
= <)==='> =7 g package com.acme.extended.operators; - =
] 1 5
com.corticon.eclipse.stud o ]
= . P import com.corticon.services.extensions.ICcStringExtension; lz k =
=i JRE System Library [Ja \‘!\L
; Plug-in Dependencies public class HelloWorld implements ICcStringExtension # com.acn
e ’ { ‘= importd
E com.acme.extende public static S5tring getHelloWorld(String astrThis) 4 con
[1] HelloWorld javi :
© HelloWo
|5 CeBtensionsLocat return "Hello World”; o % geth
i (= META-INF 3
Jfk MANIFEST.MF )
I [mb build.properties
Ll
] » < [ ’
’_2_ Problems &% @ Javadoc @) Declaration ~ =0
0 items
Description - Resource Path Location
< 1, Pl m r
o® Writable Smart Insert 4:1
L

Exporting your plug-in

Close all open editors, right-click your Project in the Package Explorer view and select:

Export... > Plug-in Development > Deployable plug-ins and fragments:
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Installing your plug-in

F B
= Export E@g

Deployable plug-ins and fragments

Export the selected projects into a form suitable for deploying in an Eclipse
product

e a

Awailable Plug-ins and Fragments:

I com.corticon.eclipse.studio.operations.extended.core (5.31) Select All

Deselect All
Working Set...

1 of 1 selected.

Destination lgptions] JAR Signing ]

@ Directory:
C\Users\David\Desktop -
) Archive file:
Browse...
() Install into host. Repository:
Browse...
@ Mext » ’ FEinish ] ’ Cancel ]

S

Navigate to your preferred output directory, and then click Finish.

An installable plug-in is created in your output directory:

g‘\) v . » plugins = | +4 Wl Search plugins p
Organize v 8 Open ~ Share with M New folder =- 0 ®
=
i Favorites T Name

Bl Desktop ‘ @ com.corticon.eclipse.studio.operations.extended.core_5.1.3.jar

& Downloads

il Recent Places

i Libraries ~ o ‘ :

com.corticon.eclipse.studio.operations.ex... Date modified: 7/13/2011 11:44 AM Date created: 7/13/2011 11:44 AM
WinRAR archive Size: 147 KB

Installing your plug-in

Copy your exported plug-in into the target Eclipse environment /plugins directory.

It is important that you restart your target Eclipse environment with administrator privileges
whenever you update your plug-in so that the plug-in gets properly installed and registered.

It is a good practice to use the —c1ean command line option when you restart Eclipse to force the
system to rebuild the bundle cache, ensuring that your changes take effect.
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Testing your extension

Create a Rule Project as a home for your Corticon test assets. Switch to Corticon Designer

perspective by selecting:

Window > Open Perspective > Other > Corticon Designer, and then click OK. The system

rearranges the editors and views as shown:

= Rule Modeling - com.corticon.eclipse.studio.cperations.extended.core/src/com/acme/extended/operatars/HelloWorld java - Eclipse SDK

File Edit Source Refactor Navigate Search Project Run Window Help

o-E& B85 5 $-0-Q- &y POAEED
vl ayD-

& Rule Vocabulary &2 ‘155 ¥ = 08| HelloWorld.java &% -ﬁrcom.cortlcon‘acllpse.;tudlo‘nperatmns‘extanded.core

package com.acme.extended.operators;

public class HelloWorld implements ICc3tringExtension
{
public static String getHelloWorld(S5tring astrThis)
{

| y

return "Hello World”;

&® Rule Operators | L@ Rule Project Explorer 5% =g
== P

1 " " "
com.corticon.eclipse.studic.operations.extended.core
= s s D Rule Statements &2 (3 Rule Messages

L
= Properties [ Problems &2 @] Errer Log
0 items
Description -
|
] n
| [E—s

Wiitable Smart Insert 4:1

Eg Rule Modeling

import com.corticon.services.extensions.ICcStringExtension;

Right-click in the body of the Rule Project Explorer and select New > Rule Project
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Testing your extension

Project

1|
Create a new project resource.

Project name:  HelloWorld

Use default location

Location: | D:\GalileoClassic\workspaceiHelloWorld

‘ | Browse...
Working sets

Add project to working sets

Wiorking sets:

-] Select..

@ \

<Back || Net> |[  Fnish ||

Cancel l

Enter HelloWorld in the Project name field and press Finish.

The system will create a new Rule Project visible in the Rule Project Explorer:

r n
= Rule Modeling - :om&oﬂiconid'w ore/src/com/acr o s/t java - Eclipse SDK‘Q‘@M
File Edit Source Refactor Navigate Search Project Run Window Help
mi i | [y S i%-0- Q- ®P- P JET B & Java »
i« & = %2 - - e
& Rule Vocabulary &2 zE 7= 8|m HelloWorld.java &2 ﬁcom.cortlcon‘acllpse.studlo‘nperatmnsﬁttanded.core W =8
package com.acme.extended.operators; -
import com.corticon.services.extensions.ICcStringExtension;
public class HelloWorld implements ICc3tringExtension
{
o public static String getHelloWorld(String astrThis)
{
return "Hello World”;
}
}
fRuIe Operators ﬁ“m’ m ﬁ i =0
&~ 4 v
1 " " "
i+ 1=% com.corticon.eclipsestudio.operations.extended.core E =
e Rule Statements &5 2 Rule Messages g8
» [i== HelloWarld| & ges|
= Properties [ Problems &2 @] Error Log] =
0 items
Description . Resource Path
L] m 3
0® & HelloWorld

Right-click the HelloWorld project and select New > Rule Vocabulary:
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— e
= Create New Vocabula _Eh

I Yocabulary Il
Create a new Vocabulary

Enter or select the parent folder:

HelloWorld

iy

12 com.corticon.eclipse.studio.operations.extended.care

1= HelloWorld

File name: HelloWorld

@ [ Enish ][ cancel |

Enter HelloWorld in the File name field and press Finish.

The system will create a new Vocabulary:

r M
& Rule Modeling - HelloWorld ipse 5D [E=N =R

File Edit MNavigste Search Project Vocabulary Run Window Help

‘-EHE B LYY 3SR ia-is-ib-E-ve-o-iaan H & .
2l Rule Vocabulary 5 i= 7 7 O[5 HelloWorld.java f& com.corticon.eclipse.studio.operations.extended.core w
2] HelloWorld ] HelloWorld Customn Data Types

Data Type Ma... BaseData Type Enumerati.. Constr.. ~  Label | Value =

m
m

&® Rule Operators ¢ Rule Project Explorer i3 =0

s 7 - -
122 com.corticon.eclipse.studio.operations.extended.core
=2 HelloWorld Rule Statements 2% . 1 Rule Mssags] =

¢ HelloWorld.ecore

= Properties [ Problems &2 @] Error I.og] ¥ =0

0 items
Description . Resource Path
] m "

‘r
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Testing your extension

In the Vocabulary Editor, right-click the HelloWorld root node and select Add Entity to create a

new entity Customer:

. — o
2 Rule Modeling - HelloWorld/HelloWorld. ipse SDK [E=N =R

File Edit MNavigste Search Project Vocabulary Run Window Help

C-E& i8] W3 Q- ifr i H e B & i ”
& Rule Vecabulary & = 7 7 O|[ 4 HelleWorld java f& com.corticon.eclipse.studio.operations.extended.cor = =B
2] HelloWorld 4 [Z] HelloWorld Property Name Property Value
=1 Customer =] Customer! Entity Name Customer
Entity Identity
Inherits From
f Rule Operators ﬁ Rule Project Explorer 52 =g
P ) P
%~
122 com.corticon.eclipse.studio.operations.extended.core
=% HelloWorld Rule Statements &% 4 Rule Masags] =0
¢ HelloWorld.ecore
= Properties [ Problems &2 @] Error Log] ¥ =0
0 items
Description . Resource Path

0¢

Right click Customer and select Add Attribute to create String attribute name:
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- N
2 Rule Modeling - HelloWorld/HelloWo ipse SDK [E=RrEE

File Edit MNavigate Search Project Vocabulary Run Window Help
C-EH& #| WM S5 Q- P if-F-oe-D-i0a@e B &' lova ”
[ Rule Vecabulary iz 7 7 O|[ [ HelloWorld java f& com.corticon.eclipse.studio.operations.extended.cor =) =8
2] Hellowaorld 4 [ HelloWorld Property Name Property Value
= Customer 4 =] Customer Attribute Name name
= name {=] name! Data Type String
=L DANEE Mandatory No
Mode Base
f Rule Operators ﬁ Rule Project Explorer &2 =8
8~
122 com.corticon.eclipse.studio.operations.extended.core
1= HelloWorld Rule Statements &2 CA Rule Masags] =0
@ HelloWorld.ecore
= Properties [ Problems &2 @] Error I.og] =
0 items
Description . Resource Path
L] m 3
D<>

Press Save to save your new Vocabulary.

Select the HelloWorld project in the Rule Project Explorer and select New > Rulesheet:

e ——)
X

|
Rulesheet
Create a new Rulesheet

Enter or select the parent folder:

HelloWorld

122 com.corticon.eclipse.studio.operations.extended.core
1= HelloWorld

File name: HelloWorld|

@ [ <pack [ Net> J[ Fnish | [ cancel

Press Next and then select the Vocabulary asset you created in the prior step:
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Testing your extension

Rulesheet

Select Vocabulary

i

4 1= HelloWorld

|E@ HelloWorld.ecore |

» 12 com.corticon.ecli psestudio.operations.extended.core

Presentation Metaphor | Decision Table

@ [o<Back | mets |

Einish I [ Cancel ]

Press Finish and the system will create a new empty Rulesheet.

Update your Rulesheet as shown:

File Edit Mavigate Search Project Rulesheet Run Window Help
B el H HmRE L e2es 0000
T R P R T IR AR
Rule Vocabula HelloWorld.ecore
=] ry =~ —Aa =g
121 HelloWorld Conditions 0 1 2 (4]
E Customer a  Customer.name.getHelloWorld ‘Hello Werld' ather E
= name b 1
3
d
e
f
: g
h i
i
J
k E
Actions < fm ] P
Post Message(s) i | i E|
A | Customername = Customer.name.getHelloWorld O O
B
C
D
E i
E
G
H
I
J -
Overrides
Rule Operat Rule Project Explorer 27 - = 0
Mﬁ ule Frope plorer P Rule Statements &2 [ Rule Masags) =0
=
= Ref |ID Post Alias Text -
12 com.corticon.eclipse.studio.operations.extended.cc 1 Info Custormer Extension worked. ]
= HelloWorld 2 Warning Customer Extension did not work.
¢ HelloWorld.ecore
@ HelloWorld.ers
o
< . I v
E Properties 52 ~_[20 Pmmems]@amr Log] =~ =0
Rulesheet Rule Vocabulary:  platform:/resource/HelloWorld/HelloWorld.ecore Browse..
4 [T 3
o
Press Save to save your Rulesheet.
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Right click on your HelloWorld project and select New > Ruletest. Specify HelloWorld in the

File name field:

Ruletest

Create a new Ruletest

B>

e

Enter or select the parent folder:

HelloWorld

1= HelloWorld

122 com.corticon.eclipse.studio.operations.extended.care

File name: HeIIoWorId‘

@ < Back et > Finish
Press Next.

Select your Rulesheet HelloWorld.ers as the Test Subject:
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Testing your extension

-
= Create New Ruletest

Ruletest
Select Test Subject

Local

iy

4 1= HelloWorld

Iﬁ HelloWorld.ers |

Remote Servers

i =% com.corticon.eclipse.studio.operations.extended.core

http://localhost:8082/axis

https://rulescloud.corticon.com/server

8082

Update list

Remnote Decision Services

r @

Next >

[

Finish

J

Cancel

Press Finish and the system will create an empty Ruletest asset.
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File Edit MNavigste Search Project Ruletest Run Window Help

Cr-E&l @ & BIRBEE A DD B
| | WSS E Q- i Fr i H oo
& Rule Vecabulary & i ¥ = O[l@ Helloworld.ecore fﬁ HelloWorld.ers W
121 HelloWorld |2 untitled 1 |
& Customer /HelloWorld/HelloWorld.ers
=] name
Input Qutput Expected
g
i
i
Rule Operat Rule Project Explorer 27 - = 0
Mﬁ E— LSS Rule Statements | 1 Rule Messages &2 =0
&~
Severity Message Entity
122 com.corticon.eclipse.studio.operations.extended.cc
1= HelloWorld
¢ HelloWorld.ecore
@ HelloWorld.ers
& HelloWorld.ert
E Properties 32 . [21 Problems] @] Error Log] =¥ =0
Ruletest RuleVocabulary: platform:/resource/HelloWorld/HelloWorld.ecore Browse...
Testsheet
< " 3
o

Drag entity Customer from the Vocabulary view to the Ruletest input tree:
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File Edit MNavigate Search Project

Wi
H-Hel & HlB®mE 8088 wEe &R ¢ [ Rule Modeling | 5 Debug 4= Plug-in Deve...
B | [ > - i fr BTG & Javo
21 Rule Vocabulary 52 =~ = 0Ol@y ecore R ¢ s @t et 5 =0
121 HelloWorld 2 untitled_1 |
& Customey, /HelloWorld/HelloWorld.ers
= name
Input Output Expected
4 (=] Customer [1]
=] name [Test]|
b
L
Rule Operat: Rule Praject Expl z~_ =08 =
| &P Rute Opetors | 6 Rute roect eplore = Rule Statements | I Rule Messages 37 5
=
. 25 Severity Message Entity
= com.corticon.eclipse studio.operations.extended.cc
= HelloWorld
[ HelloWorld.ecore
E HelloWorld.ers
[ HelloWorld.ert
= Properties £ [£. Problems| @] Error Log)| =¥ =0
Ruletest Rule Vocabulary: ~platform:/resource/HelloWaorld/HelloWorld.ecore
Testsheet
Comments
<[ i v
e
i

Important: Double-click Customer[1] name and enter value Test.

Select Ruletest > Testsheet > Run Test and you should see the following test results:
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& B Rule Modeling | % Debug <= Plug-in Deve...
=8

.
= Rule Modeling -
File Edit MNavigste Search Project Run Ruletest Window Help
co-EHel 4] B ERpE AR R ER
$| ‘ ¥ * T * # * %v an —‘) e 7’ e <::lv - @OJJE"E
& Rule Vecabulary & i ¥ = O[l@ Helloworld.ecore fﬁ HelloWorld.ers ﬁ‘_’e *HelloWorld.ert 52
] HelloWorld 2] untitled_1 ‘
S Customer HelloWorld/HelloWorld.ers
Input Qutput Expected
1 Customer[1] = Customer [1]
= name [Test] = name [Hello World]
i

Entity
Customer[1]

=
]
Rule Statements | 1 Rule Messages &2
Message

* Rule Operators ﬁ Rule Project Explorer 2
B% Severity
122 com.corticon.eclipse.studio.operations.extended.cc
= HelloWorld Info Extension worked.
= Properties | [21 Problems | €] Error Log 53 EE " BB X #& ¥ =0
Warkspace Log
|
Message - Plug-in Dat
4 [ 3 N . »
0
If you see Hello World inthe output tree, congratulations! Your extensions are working properly.

Troubleshooting extensions
If your extensions are not properly written or deployed, the system will color Rulesheet expressions

red and will display validation messages in the Problems tab:
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E_Rule Modeling - HelloWorld/HelloWorld.ers - Eclipse S| [E‘ﬂ‘g!l

File Edit MNavigate Search Project Run Rulesheet Window Help
™ = M= | BRI Ed | B | 1 [E2 Rule Modeling | 45 Debug <+ Plug-in Deve...
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] HelloWorld Conditions 0 1 2 -
£ Customer a | Customername.getHelloWorld - ‘Helle World' other 5| I
b =
3
d
e
f
9
h
Actions < n P
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B
C
D
E
F
€]
T -
Overrides
[ Rule Statements &2 [0 Rule Messages =0
&® Rule Operators | [ Rule Project Explorer 22 .~ O]/ Ref |ID Post Alias Text -
= 1 Info Customer Extension worked. |
E% . E
2 Warning Customer Extension did not work.
122 com.corticon.eclipse.studio.operations.extended.cc
2 HelloWorld
Q HelloWorld.ecore
@ HelloWorld.ers .
= 4 1, 3
‘© HelloWorld.ert
= Properties [2: Problems £3 @] Error Log ¥ =0
2 errars, O warnings, 0 others
Description -
4 3 Errors (2 items)
@ getHelloWorld is not a valid call on [Customer.name].
@ getHelloWorld is not a valid call on [Customer.name].
< (] B KN n L2
e

For Attribute Extended Operators, validation messages will indicate that your method is not a valid
call on an attribute. There are several possible causes for this type of error.

Extension plug-in not resolved by Eclipse

Your plug-in might not be properly started and resolved by Eclipse. One quick way to check this
is to select:

Help > About Progress Developer Studio > [Installation Details] > [Configuration]

then check the P1ug-in Registry to see the status of your extensions plug-in:

com.corticon.eclipse.studio.deployment.ui (5.4.0.0) "Deployment UI" [Starting]

com.corticon.eclipse.studio.drivers.core (5.4.0.0) "Drivers Core" [Starting]

com.corticon.eclipse.studio.drivers.datadirect.core (5.4.0.0) "Drivers

DataDirect Core" [Starting]

com.corticon.eclipse.studio.extension.core (5.4.0.0) "Vocabulary Extension

Core Plug-in" [Starting]

com.corticon.eclipse.studio.operations.extended.core (5.4.0.0) "Extended

Operators Core Plug-in" [Resolved]

com.corticon.eclipse.studio.extension.ui (5.4.0.0) "Vocabulary Extension UI

Plug-in" [Active]

com.corticon.eclipse.studio.importwizards.core (5.4.0.0) "Import Wizards Core"
[Starting]

com.corticon.eclipse.studio.junit.core (5.4.0.0) "JUnit Core" [Starting]

In this example, the plug-in has been installed and properly [Resolved].
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If your plug-in is missing from this list, ensure that you have properly copied it into the Eclipse
/plugins directory.

Remember to start Eclipse with the —c1ean commandline option. This forces the system to rebuild
the bundle cache so that your new plug-in code is recognized.

If your plug-in is present in the list but not marked as [Resolved] there may be some problem
with the plug-in manifest. Carefully review MANIFST . MF to ensure all of your specifications are
correct.

Tips for troubleshooting bundle start failures can be found in various Eclipse online forums.

Extension locator file not set up correctly

If your plug-in has been correctly [Resolved], ensure that your extension classes implement the
correct marker interface(s) and that CcExtensionsLocator. lc is present in the root of your
plug-in Jar.

Also, review the MANTIFEST.MF Export-Package clause carefully. It should appear as follows:
Export-Package:
com.acme.extended.operators;

Note that in the Export-Package clause, you must export period(.) to ensure that
CcExtensionsLocator. lc is properly exported. If this specification is in error or missing, the
system will fail to locate your classes.

Extension classes not implementing marker interfaces

Ensure that your classes implement the proper marker interfaces (for example,
ICcStringExtension); otherwise, the extensions subsystem will ignore your class.

Enabling logging to diagnose extensions issues

When you enable INFO-level logging, it will help diagnose extensions discovery issues. To change
the log level, edit the brms.properties file at the root of the work directory to set the override:

loglevel=INFO

When you you restart, the extensions subsystem will log messages as it tries to locate your
extension classes.
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You might see this type of output if your plug-in fails to properly export (.):

CcUtil.getAllLocationsOfFile() .. START

CcUtil.getAllLocationsOfFile() .. astrResourceName = CcExtensionsLocator.lc
com.corticon.extensions.CcExtensions|CcExtensions () loadClassesFromJars () ==
Start

com.corticon.extensions.CcExtensions|CcExtensions () loadClassesFromJars ()
asetJarLocations == []

CcUtil|CcUtil.getAllLocationsOfFile() .. START
com.corticon.extensions.CcExtensions|CcExtensions () loadClassesFromDirectories ()
== Start

com.corticon.extensions.CcExtensions|CcExtensions () loadClassesFromDirectories ()
asetDirectoryLocations == []

In the log output above, the extensions subsystem is unable to find CcExtensionsLocator.lc
either because it is missing or not properly exported.

In contrast, here is what you will see in the log if the extensions subsystem is able to find your
locator and extension classes:

CcUtil.getAllLocationsOfFile() .. START

CcUtil.getAllLocationsOfFile() .. astrResourceName = CcExtensionsLocator.lc

CcUtil.getAllLocationsOfFile() .. 1lURLLocationPath =
bundleresource://17.fwk25860399/CcExtensionsLocator.lc

CcUtil.getAllLocationsOfFile() .. lstrProtocol = bundleresource

CcUtil.getAllLocationsOfFile( AFTER RESOLVER ) .. lURLLocationPath =

jar:file:/C:/Program Files/Progress/Corticon
5.4/Studio/eclipse/plugins/com.corticon.eclipse.studio.operations.extended.core

~5.4.0.jar!/CcExtensionsLocator.lc
CcUtil.getAllLocationsOfFile(1l) .. lstrPath =

file:\C:\Program Files\Progress\Corticon
5.4\plugins\com.corticon.eclipse.studio.operations.extended.core
~5.4.0.jar!\CcExtensionsLocator.lc
CcUtil.getAllLocationsOfFile(2) .. lstrPath =

file:\C:\Program Files\Progress\Corticon
5.4\plugins\com.corticon.eclipse.studio.operations.extended.core
~5.4.0.jar!\CcExtensionsLocator.lc
CcUtil|CcUtil.getAllLocationsOfFile() .. END =

[file:\C:\Program Files\Progress\Corticon
5.4\plugins\com.corticon.eclipse.studio.operations.extended.core
_5.4.0.jar!\CcExtensionsLocator.lc]
com.corticon.extensions.CcExtensions|CcExtensions () loadClassesFromDirectories ()
== Start
com.corticon.extensions.CcExtensions|CcExtensions () loadClassesFromDirectories()

asetDirectoryLocations == []

As shown above, getAllLocationsOfFile is able to find your extensions. This is a positive
sign and if you see such output in the log, it is very likely that your extensions will work properly.
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Documenting your extensions

In order for your extensions to be visible in the Rule Operators tree view, they must be properly
documented in a special file named ExtendedOperators.operationsmodel. This file is in
EMF/XMI format and can be maintained using either a text editor an EMF-generated editor supplied
with Corticon Studio. Refer to the example ExtendedOperators.operationsmodel file in:

com.corticon.eclipse.studio.operations.extended.core

During system initialization, the system will attempt to locate
ExtendedOperators.operationsmodel on the Java class path; if the system finds this file,
it will automatically merge the documented extended operators into the Rule Operators tree view.

ExtendedOperators.operationsmodel supports internationalization. The object model
permits localization of folder names, extended operator names, parameter names and tooltips.
This is accomplished via EMF "multi-valued" attributes, which are essentially lists (arrays) of values.
Each "slot" in the array contains a particular localization (i.e., a string expressed in one of the
supported languages).

The first localization in each "slot" is special and is referred to as the "base" localization. For class
and method names, the "base" localizations must match the class and method names in your java
extension classes.

The root object of the model (ExtendedOperatorSet) contains a list of Java LanguageCode
instances that defines the set of languages supported. The order of language codes is important
and must match the order of localizations expressed elsewhere in the file.

The system will merge typed extensions into the Rule Operator tree at the end of the built-in
operators. For example, String Attribute Extended Operators will be appended to the "String" data
type node of the Rule Operator tree after the built-in String operators.
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The system will append Stand Alone extensions to the end of the Rule Operator tree. The Stand
Alone extensions will be contained within a special folder whose name is declared in

ExtendedOperators.operationsmodel (see ExtendedOperatorSet.standAloneFolderName).
In our example, the name of the Stand Alone extensions folder is simply Extended Operators.

Our example ExtendedOperators.operationsmodel contains English descriptions of
operators, and is set up to handle Japanese localizations as well, although the only Japanese
localization specified is the Stand Alone folder name.

Refer to example ExtendedOperators.operationsmodel file as a guide documenting your
own extensions.
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Precompiling ruleflows with service call-outs

As described in the "Deploying Corticon Ruleflows" chapter of the Server Integration & Deployment
Guide, you can pre-compile Ruleflows prior to deploying them. When pre-compiling Ruleflows with
Service Call-outs (SCO), it is important to ensure the following:

1. Place the SCO JARs on the Deployment Console's classpath. This is accomplished by editing
the deployConsole.bat file located in [CORTICON HOME]\Server (or your chosen
installation directory).

2. Once the Ruleflow has been compiled to an . eds file using the Deployment Console, add your
. eds file, along with any other JARs required by the SCO, to the Server directory which holds
CcServer.jar. In the default Corticon Server installation, this is
[CORTICON HOME]\Server\pas\corticon\webapps\axis\WEB-INF\lib.
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